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About this Manual

This manual distinguishes between different types of information
by using the following conventions:

S Terms taken from the interface (commands, etc.) are dis-
played in bold .

S Keys are displayed in upper case letters, as in the following
example: ”Press the SHIFT” key.

S New terms are displayed in italic when first defined.

S When the conjunction ”or” appears next to a paragraph, it
means that another procedure can be used to carry out a
given task .

S When a menu command contains submenus, the menu name
followed by the command to be selected is displayed in bold.
Therefore, ”Choose File, Open” means you must select the
Open command from the File menu.

S Numbered lists identify descriptions of procedures.

This symbol highlights important information about how a partic-
ular command or procedure works.

Following this symbol, you will find hints and tips for optimizing
tasks, speeding up commands, and so on.

Some of the functions described in this manual may not be
available in your product.

For the complete list of specific features and functions available
in your software, refer to the specification sheet provided with
the product.

Typographical
conventions

About your
product





Installing

Functional description

To use the network/multi-user version of your labelling software,
you must install the Network Manager on the server or on a
station that will serve as a server, then install the labelling
software on each station.

Installation
of the
Network
Manager

Network configuration installation: installation of the
Network Manager on the server and installation of the
labelling software on each workstation.

Workstation

Workstation

Workstation
Workstation

Figure 1 Description of the installation on a network
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Chapter 1 -- 2 Administrator’s Guide

Product description

The software is designed to run on any PC or IBM compatible
computer that can support the Microsoft WindowsR graphic
environment. It is compatible with WindowsR 98SE, Win-
dowsR ME, WindowsR 2000 SP2 and SP3,WindowsR NT 4
Service pack 6, WindowsR XP, WindowsR XP SP1 versions
by MicrosoftR.

Your product includes the following components:

S a CD-ROM

S complete documentation

S a license agreement and registration card

S a dongle

System requirements

The configuration needed for the software to run properly is the
same as most applications running on Windows:

S a PC or IBM compatible computer supporting
WindowsR 98SE,WindowsR ME,WindowsR 2000 or
WindowsR NT 4

S WindowsR 98SE or ME with 64 MB RAM (128 MB recom-
mended)
WindowsR NT or 2000 with 64 MB RAM (128 MB recom-
mended)
WindowsR XP with 128 MB RAM (256 MB recommended)

S a VGA monitor or better

S a hard drive with 150 MB free disk space

S a CD-ROM drive
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Installation procedure

Before you can install the software, the network administrator
must first define the structure of the network for the group of
users, specifically:

S define the license server on which the License Manager and
dongle will be installed

S define the workstations, or the client workstations that will
use the labelling software

The Network Manager lets you use the network configuration
of your labelling software. Network Manager includes:

S The license manager (License Manager and Service)

S Network Settings Wizard

S User Manager

The Network Settings Wizard helps you define the network
configuration.

The User Manager is installed with the Network Manager so
you can define access rights to the labelling software in a
network setting.

The dongle must be installed on the computer (server or
workstation) on which the license manager is installed. A single
dongle, pre-programmed with the number of licenses purchased,
is included with the network version of your software.

The dongle must be installed before the license manager
(License Manager or Service) can be started.

Parallel port/DB25 female connector

PC

Dongle

PC

Figure 2 Connecting the dongle to the parallel port of your PC

USB port

Dongle

Figure 3 Connecting the dongle to the USB port of your PC

Before you
start

Description of
Network
Manager

Installing the
dongle
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Note When you start the program, if the dongle does not match the
product version, a dialog box with the necessary instructions is
displayed.

If you need to use a printer on the parallel port, connect it to the
dongle. In this case, you might have to turn the printer on in
order for the dongle to be recognized.

Before installing the labelling software on all the workstations
that will use it, you must install the Network Manager on the
server to configure the network.

"""" To install the Network Manager on the server.

1 Connect the dongle.

2 Insert the CD-ROM in the appropriate drive.

The Installation window is displayed.

If the CD-ROM does not run automatically:

3 Choose Start, Run, then type the letter of the CD-ROM
drive, followed by CDSETUP.EXE (for example, type D:\cdse-
tup.exe).

4 Select Network Manager, which includes License Manager,
Service and User Manager. Then click the Install button
and follow the instructions on the screen.

The License Manager and Service are used to manage
licenses. Service only runs on Windows NT, 2000 and XP
systems.

5 Share the [DONGLE] folder with full control, using
TKDONGLE as the share name. The default access path
for this folder is C:\PROGRAM FILES\TKI\7\COMMON\TOOLS\DONGLE.

6 If you want to define settings for your network configuration,
start the Network Settings Wizard on the server. By
default, if you do not modify the configuration, each worksta-
tion will have its own settings.

"""" To configure the network version

The Network Settings Wizard helps you define the settings for
your network version.

Installing the
Network
Manager on
the server

Setup
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1 To start the Network Settings Wizard, choose Start, Pro-
grams, Network Manager and Network Settings Wizard.

2 In step 1 of the wizard, select a settings mode: generic, by
user or by station.

generic: all users will use the same settings on all worksta-
tions. (user.ini)

By user: each user can access his or her own settings on any
workstation. (user name.ini)

By station: each workstation has its own settings
(station.ini)

3 In step 2, specify the location in which you want to store
these settings. If you want to share these settings between
various workstations, specify a network path accessible to all
workstations.

4 In step 3, specify the location in which you want to store the
shared data (variables, lists, printing logfile, etc.).

"""" To configure the User Manager

If you want to define network access rights for all users of the
labelling software, you must do so during installation (consult
the User Manager help system).

S Choose Start, Programs, Network Manager and User
Manager.

Before installing the labelling software on all workstations, you
must start the license manager.

If the license manager was installed as Service, you do not need
to start it. In fact, Service starts when the workstation is turned
on and runs as a background task as long as the workstation is
on.
However, if you installed the License Manager, you must start it
manually.

"""" To start the License Manager

S Click the icon

-or-
Choose Start, Programs, Network Manager and License
Manager
-or-
double-click the LICENSE.EXE file in the [DONGLE] folder in C:\PRO-
GRAM FILES\TKI\7\COMMON\TOOLS\

To start License Manager automatically when a Windows ses-
sion is started, copy the shortcut for the program to the Start,
Programs, Startup menu in Windows.

Starting the
license
manager
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The labelling software must be installed on all the workstations
on which it will be used.

"""" To install the software on a workstation

1 Insert the CD-ROM in the appropriate drive.

The Installation window is displayed.

If the CD-ROM does not run automatically:

2 Choose Start, Run, then type the letter of the CD-ROM
drive, followed by CDSETUP.EXE (for example, type D:\cdse-
tup.exe).

3 Select the product to be installed, click the Install button
and follow the instructions on the screen.

4 Start the labelling software. A message is displayed to inform
you that no dongle has been found. Click Yes to start the
software.

5 From the Tools menu, choose Network Administration.

6 Enable Use Network License.

7 Click Modify to select the server on which the license man-
ager and dongle are installed.
- or -
Click Browse to automatically search for the server on which
the license manager is installed.

If the network has already been configured, a message ask-
ing if you want to use the current network configuration is
displayed.

8 If you want to modify or configure the network settings, click
the Network Settings Wizard button.

9 Click OK.

10 Restart the program.

If the server is changed, you will have to update all of the
workstations. In this case, start the labelling software and
choose Tools, Network Administration. Disable and re-enable
the Use Network License option.

You can also install the Network Manager on a workstation that
will be used as a server.

S Proceed in the same manner as for installing on the server.

S Install the labelling software on the workstation.

If you are installing on a workstation, the various Network
Manager programs will start in the language selected in the
labelling software.

Installing the
software on
the
workstations

Installing
Network
Manager on a
workstation
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Managing users

The license manager must be installed on the station, server or
workstation to which the dongle is connected.

"""" To start the License Manager

S Click the icon

-or-
Choose Start, Programs, Network Manager and License
Manager
-or-
double-click the LICENSE.EXE file in the [DONGLE] folder in
C:\PROGRAM FILES\TKI\7\COMMON\TOOLS\DONGLE

"""" Functional description

The license manager can be started and opened from an icon on
the Windows taskbar. It must remain active whenever the
labelling software is used by one or more users.

If the license manager encounters a problem at start-up, it will
start in window mode and display an error message (the dongle
was not recognized, etc.). Refer to Chapter 2 - 3, Trouble-
shooting.

"""" Description of the License Manager window

Once started and the window is enabled, the License Manager
window is displayed as follows:

License
Manager

2
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Figure 4 Main window of the License Manager

The License Manager window displays the list of users. This list
permanently displays the ”login” name of those currently using
the labelling software.

The toolbar

Button Use

Closes the program. Caution. The program should
not be closed until all users have logged off. A
warning message is displayed if you try to close
the program while one or more users are still
connected.

Displays the About dialog box. This dialog box
displays the version number of the program.

Refreshes the display: the list of users may not be
updated in certain cases, such as if a workstation
crashes (to reset, press CTRL + ALT + DEL)

The status bar

At the bottom of the window, the status bar displays the
maximum number of users that can be connected at any given
time for your version of the program.
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"""" Troubleshooting

Two types of error messages may be displayed. The table below
lists possible problems and describes the troubleshooting
procedure.

Message Solution

Could not find the
dongle

- the dongle is not connected.

- the dongle is connected to the wrong port
(serial port, for example).

- a printer is connected to the dongle and
is switched off.

License Manager
cannot create the
license file

The license file could not be created in the
[DONGLE] folder. This may mean that a user
on the station on which License Manager
was started does not have the access
rights required to write to this folder. The
network administrator must assign the
required access rights (read, write, delete
and modify, if applicable).

"""" Changing the standard settings for the license manager

Using the command line

The standard behavior of the License Manager can be changed
by using a parameter in the program’s command line.

1 Choose Start, Run from Windows main menu.

2 Type the access path to the [Dongle] folder or click Browse.

3 Select license.exe, press the spacebar and type /X (upper
case).

The license manager is displayed in window mode, rather
than as an icon.

This module is only available if you have installed the Service
mode of the license manager on a Windows NT, 2000 or XP
workstation. The license manager is installed as a service. This
service, referred to as SLicense, is enabled automatically when
the server is turned on.

The Service Control module, n a me d
SL I CE N SE CTRL .E XE, is use d to control h ow the se rv ice f unctions a nd
to change the standard behavior of the license manager. You
can, for example:

S Start or stop the service

Service control
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S Display the list of users connected to the labelling software

"""" Description of the Service Control window

S To start Service Control, select Service Control from the
Network Manager program group.

Once started and the window is enabled, the Service Control
window is displayed as follows:

Toolbar

Indicator panel

Frame reserved for
status or error
messages.

List of users
connected to the
labelling software.

Figure 5 Main Service Control window

The Service Control window displays the list of users. This list
permanently displays the ”login” name of those currently using
the labelling software.

The toolbar

Button Use

Stops the service.

Starts the service.

Refreshes the display: the list of users may not be
updated in certain cases, such as if a workstation
crashes (to reset, press CTRL + ALT + DEL).
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Button Use

Accesses the Service Control settings dialog box.
This button is only available when the service is
stopped.

Displays the About dialog box. This dialog box
displays the version number of the program.

The Indicator Panel

The Indicator Panel displays the current status of the service.

Indicator
red: the service is
stopped.

Indicator
orange: the service
is starting up.

Indicator
green: the service
is enabled.

"""" The Settings dialog box

To access the Settings dialog box

S Click on .

The Settings dialog box is displayed.

Figure 6 The Settings dialog box
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To change the settings

If SLICENSE.EXE was not installed in the [Dongle] folder, you must
specify the access path to the license file.

1 Enter the new access path to the license file, or click the
Browse button.

2 If you want to allow the service to be stopped while users are
still logged on, check the Enable stopping while users are
connected option.

3 If you want to change the display language of the Service
Control, select the desired language from the Language list.

4 Click OK in the dialog box to update the changes.

"""" Changing the behavior of the Service

By default, the Service is started automatically when the
workstation is turned on. However, you can change the behavior
of the service in the Services dialog box in the Windows
Control Panel. Refer to the documentation supplied by
Microsoft.

Changing the service startup type

1 Select SLicense from the list of services.

2 Click Startup.

3 Enable the desired startup type, by default
SLicense is configured to start automatically.

Selecting a user account

1 Select This account in the Log on as field.

2 Type and confirm the Password and click OK in the Service
dialog box.

Your network version is limited to a maximum number of users.
This means that a 10-user license allows you to start 10 sessions
of the labelling software simultaneously.

If an eleventh user tries to log on, an error message is displayed
indicating that the maximum number of users has been reached.
He or she must wait until one of the connected users logs off.

Maximum
number of
users



Chapter 2 -- 7Network Use

The limitation on the number of users does not affect the num-
ber of workstations on which the software can be installed, only
the number of simultaneous connections. This means that you
can install it on as many client stations as you like.
Moreover, if multiple users are logged on at the same time on
one workstation, the license manager counts this as only one
user.

Managing shared resources

A document can only be opened by one user in ”read/write
mode”. If the same document is opened by other users, it is
opened in read mode only. This means that only the first user
can modify and save the document in question.

Note: The document can however be printed in ”read only”
mode.

To provide security for the work of the group, the opening mode
for documents can be defined in the Options dialog box in the
Document tab, by checking the Open documents in read only
mode by default option.

The Network Settings Wizard is used to configure data sharing
for variables, lists of values and the printing logfile.

To share data, you must specify a path and folder on the
network in step 3 of the wizard.

If you selected the generic settings mode in the
Network Settings Wizard, the printing logfile (very useful for
tracing all print jobs) can be configured in the Printing Logfile
dialog box.

To share the printing logfile with all workstations, you must first
generate the log on one of the workstations.

To generate a printing logfile

1 Choose Tools, Printing Logfile.

2 Type the access path to the folder in which shared data is
saved and a file name for the Printing Logfile, then select a
text editor.

Shared
document files

Shared data

Shared
printing logfile
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3 Enable your options in the Options tab. For more information
on the Printing Logfile, refer to the Online Help system.

Note As with shared variables, if multiple users are working on the
same file, only one Printing Logfile is created and it traces all
print jobs for each user. However, a user can generate a perso-
nal file.

When a shared file, such as a file of shared variables, is opened
by a user, it cannot be accessed by other users who must wait
until it becomes available. After a timeout period (defined by
you), a message is displayed asking the user if he or she wants
to continue waiting or cancel the request.

"""" To define the timeout period

1 Choose Tools, Options.

2 Click the Others tab.

3 Type a value in the Shared files access timeout period
(ms) text field.

A flashing colored indicator indicates the status of the current
print job in the print status dialog box. This status is only dis-
played if you display the print dialog box in the labelling soft-
ware.

S Green: the data is being printed

S Orange: a user is currently using a shared resource (printer
or variable).

S Red: error.

"""" To display the print dialog box

1 Choose Tools, Options and click the Printing tab.

2 Disable the Hide the Cancel Print dialog box option.

Shared file
timeout period

Printing
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Notes for the network administrator

This section describes folders on the server and workstations,
and the required access rights.

"""" Folders on the server

During installation, the [DONGLE] folder is created. It is
important for each user to have ”read/write” access to the
shared TKDONGLE folder.

"""" Folders on the workstation

The folder in which the software is installed must have ”Read,
Write, Modify, Create” access rights.

The table below describes each of the sub-folders of the
[Common] folder and the required access rights. The access
path to this folder is C:\PROGRAMFILES\TKI\7\COMMON

Folder Rights

[COMMON] Read

[COMMON]\HELP Read

[COMMON]\TOOLS\BATCHER Read

[COMMON]\TOOLS\CONVERTER Read

[COMMON]\TOOLS\EAN128 Read

[COMMON]\TOOLS\MAXICODE Read

[COMMON]\TOOLS\POF Read

[COMMON]\LFM Read
Write
Modify
Create

[COMMON]\DEVICES Read
Write
Modify
Create

[COMMON]\TOOLS\COMET Read
Write
Modify
Create

[COMMON]\TOOLS\DMANME Read
Write
Modify
Create

Folders
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Folder Rights

[COMMON]\TOOLS\DONGLE Read
Write
Modify
Create

[COMMON]\TOOLS\HTML Read
Write
Modify
Create

Example of sharing a printer

Based on the type of network or the requirements of your
organization, many configurations are possible. This section
provides an example of sharing a printer in a Windows
environment.

The following example shows how a thermal transfer printer can
be shared between a number of users in a Windows 98 or ME
environment.

"""" To share a printer

1 Install a printer on one of the network workstations (refer to
the on-line help system, Printing heading, Add a printer
section) with shared access rights.

Note When you add the printer, do not check the Direct Access
option because this prevents the printer from being shared.

2 Choose Start, Settings, Control Panel from the main Win-
dows menu.

3 Double-click Network.

The Windows Network dialog box is displayed.

4 Click File and Printer Sharing.

The File and Printer Sharing dialog box is displayed.

5 Check the I want to be able to allow others to print to
my printer(s) option and then click OK.

6 Choose Start, Settings, Printers from the main Windows
menu.

The Windows Printers dialog box is displayed. You will notice
that the thermal transfer printer that you added is displayed
in the list as THT, followed by the name of the port to which
it is connected.

Sharing a
printer in
Windows
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7 Select this printer and click or choose Properties from

the context menu.

The printer properties dialog box is displayed.

8 Click the Sharing tab.

9 Check the Shared As option, enter a share name for this
printer and, if necessary, a comment.

Note According to the type of access control defined, the Properties
dialog box may look different. For more information, refer to
the Microsoft documentation.

"""" To install a shared printer on the network

Users who want to use a shared printer installed on another
workstation must add the printer on his/her own workstation
(see Online Help, Printing heading, To add a printer section).

1 Choose File, Select Printer

2 Click Add.

The Add Printer dialog box is displayed.

3 Click Network Printers.

The Browse for Printer dialog box is displayed.

4 Select the shared network printer.

5 Click OK in the Browse for Printer dialog box.

The network address of the shared printer is displayed in the
Port list.

6 Select a printer model from the Model list and the network
address from the Port list.

7 Click OK in the Add Printer dialog box.

You can display the status of current print jobs on the worksta-
tion to which the printer is connected.

1 Choose Start, Settings, Printers from the main Windows
menu.

2 Double-click the name of the printer for which you want to
display the status of print jobs.

The Windows Print Manager window is displayed with a list
of all print jobs in progress.

Displaying
current print
jobs
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